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About this document

Content Usage Rights
This courseware was designed as a guide and handout to support session 
L200 of the online Adobe MAX 2021 conference. Users of this document are 
free to use it to deepen their knowledge of Adobe products and other non-
commercial educational benefits.

It is not allowed to edit, duplicate, sell or redistribute this document under 
your own name or use it for any other commercial purpose. All used assets 
or referenced assets are protected under copyright laws and cannot be 
distributed or used for any other commercial purpose without explicit 
written consent. Let's support creativity instead of stealing it.
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Introduction
This handout is meant to help explain the benefits of Adobe Acrobat and the 
accessibility tools and features within the program that will help you create 
more accessible content. 

What Is Digital Accessibility?
Digital accessibility is the process of making digital products (websites, 
mobile apps and other digital tools and technologies) accessible to 
everyone… providing all users access to the same information, regardless of 
the impairments they may have or the method they may use.

Accessibility Barriers
• Font

• Language

• Colorblindness

• Color Contrast

• Color as a Differentiator

• Structural Relationships

• Text as Images

• Formulas

• Tables

• Images

International (WCAG-based) Accessibility Standards 
• Argentina
• Australia*
• Bolivia
• Brazil
• Canada*
• Brazil
• Chile
• China
• Columbia
• Ecuador

• EU
• France
• Germany
• Hong Kong
• India
• Ireland
• Israel
• Italy
• Japan
• Netherlands

• New Zealand
• Norway*
• Peru
• Republic of Korea
• Spain
• United Kingdom
• Uruguay
• USA
• Venezuela

*Enforce digital content compliance for commercial and government websites.
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The Acrobat Workspace
Adobe Acrobat has three basic views and four areas to access tools and 
commands. Understanding what is in each of these areas will help you 
develop the best workflow for your situation.

The Four Interface Areas
1 . The Text Menu
The text menu at the top of the screen allows you to access every tool and 
command through a series of drop-down menus. Acrobat allows keyboard 
and mouse-driven access to these commands.

2 . The View Tabs
These consist of the Home, Tools and Document tabs. They allow you 
to switch between interface modes and provide quick access to recent 
documents, tools and your document(s). 

3 . The Panes Panel
These are the elements to the extreme left of the screen. You may have 
more or less tools in this panel. You can add tools by right clicking in the 
open area under the last tool and selecting the desired tool to add from the 
pop up list that appears. 

21

3 4
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4 . The Tools Panel
The Tools Panel (3) is located on the extreme right edge of the Acrobat 
window and houses all of the common tool shortcuts you will need when 
editing your PDF documents. You can add to these quick tools by selecting 
the Tools Tab (1) and dragging items (2) into the Tools Panel (3). To 
reorder the quick tools you will need to switch to or be in the Tools view by 
selecting Tools Tab (1) to the left of the Home Tab first.

Click on a tool in the Tools Panel to activate it or to access the tool set for 
that category. 

Accessibility Note: The tools you will use most in accessibility testing and 
remediation will be:

• Accessibility Tool
• Print Production Tool
• Prepare Forms

• Organize Pages
• Scan & OCR

2

1
3
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The Three Acrobat Views
There are three basic views in Adobe Acrobat. These views are the Home, 
Tools and Document view. Each of these views can be accessed by select 
the desired tab located just under the text menu at the top of the screen.

Home
The Home view shows your recent documents with various location filters,  
as well as, several shortcuts for Combine Files, Request Signatures, Share, 
Export PDF, Send for Comments, Protect and Edit PDF .

Tools
The Tools Tab opens a menu in the main document window allowing you 
to open, remove or add shortcuts to the Tools Panel by dragging them to the 
right and letting go in the Tools Panel.

Pro Tip: The Search Bar (1) is just under these three tabs. You can use it to 
search for partial matches to quickly find tools when you cannot remember 
what menu or area they are in.

1
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File Properties Basics

Title
The title is an important feature 
because when a document is open 
assistive technology like a screen 
reader announces the document tile 
or the file name if no title is present. 
This can present a confusing user 
experience if your filename does not 
contain a meaningful description 
of the document. A document with 
the file name 20101001_A302_
Formfinal_99.pdf does not supply 
enough information for the user to 
know what the document is. 

Language
The document language is set from 
the Advanced Tab. The language of 
the document is almost always set 
automatically. But there are many 
cases where multiple authors from 
different countries are collaborating 
on a document using different base 
languages. So it is always a good 
idea to double check to ensure the 
proper base language is selected. 
This selection directs the end-users screen reader to voice the text in the 
appropriate language. However it is worth noting that if the end user does 
not have the corresponding language pack installed, the text will not be 
voiced in that language automatically.

Accessibility Note: The shortcut to open the Document Properties Panel 
is Ctrl/Cmd + D. There are other properties like author, subject, key words, 
etc. that can be set. These can help search engines find and properly list 
your document but they are not necessary for accessibility.
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Bookmarks

Auto-generate via Headings
When your document already contains heading structures that have been 
built with accessibility in mind, the easiest way to generate bookmarks is 
by auto-generating them using New Bookmarks From Structure (2). This 
command is found in the Bookmarks Options drop-down (1). When your 
document uses Heading Levels Adobe Acrobat will generate bookmarks 
based on the depth you choose (3). It is recommended that no more 
than 3 levels deep are selected. You will need to properly nest them once 
generated. Bookmarks created from Adobe InDesign will already be nested 
when you use Automatic Table of Contents.

Manually create
To manually create bookmarks you will highlight the text on the page you 
wish to enter as a bookmark and then click the  icon to create a single 
bookmark from the selected text. The text you selected will appear in the 
bookmarks bar and be linked to that location.

2
1

3
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Tool Panels you need to know

Tags Panel
What are tags?
Tags are the specific structural markers that help identify content in a PDF 
document for assistive technology like screen readers, braille devices and 
other devices. These tags represent the visual elements on the page to 
provide a richer user experience that goes beyond simply voicing the text on 
the page. 

Activating the Tags Pane
The tags pane icon is not visible by default. To activate it you will need to 
right clicking in the blank area below your existing tools on the left side 
of the screen (1). Then you will choose Tags (2)from the Panes Options 
window. You may also want to activate the Content pane and the Order 
pane as you will likely be referencing them while remediating your 
documents.

2

1



Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro  |  Adobe MAX 2021 

13

Tags you need to know
Below are the majority of the tags that you will encounter when making 
your documents accessible. This list is meant to provide you with a basic 
overview. There are many rules about how these tags can be used and the 
properties that can be applied to them. Start small. Learn the basic tags 
and what they mean. The more you do the work the more familiar you will 
become with the tags.

Structural Elements
Structural elements are containers that hold additional content. While no 
screen reader voices these items, they do serve an important purpose. 
These containers exist at the block level to logically group page content. 

 � <Document> Document: Every document should start with a this tag.
 � <Part> Part: Sub-divides a large document into smaller elements.
 � <Art> Article: Identifies an article within a document or part.
 � <Sect> Section: Signifies the sections of a document, part or article.
 � <Div> Division: Provide metadata properties and/or attributes 
 � <Span> Span: container for ActualText, white-space characters or other metadata
 � <TOC> Table of Contents: Container signifying a list of TOC Index elements
 � <TOCI> Table of Contents Item: Single content entry with reference links or page 

numbers. This will always be nested inside a <TOC>.
 � <NonStruct> Nonstructural Element that has no grouping significance related to 

content. Think of it as a generic grouping element.
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Block-Level Elements 
These elements exist as parent elements inside the Container tags. Table 
<Table> and List <L> tags are also block-level but have been grouped for 
clarity in this list. Table, List and Paragraph tags hold inline elements. 

 � <H> Heading: Outdated Structure type. This should not be use, ever .
 � <H1> Heading 1: Can be used as many times as needed as long as you are consistent.
 � <H2> Heading Level 2: Should always be proceeded by <H1>
 � <H3>Heading Level 3: Should always be proceeded by <H2>
 � <H4>Heading Level 4: Should always be proceeded by <H3>
 � <H5>Heading Level 5: Should always be proceeded by <H4>
 � <H6>Heading Level 6: Should always be proceeded by <H5>
 � <P> Paragraph: Basic Paragraph
 � <BlockQuote> Block Quote: Block-level quote from existing text.

Table Elements
Table tags define the structure of a table. The <Table> is the Parent tag and 
all other tags are nested inside it. The table can be divided into regions for the 
header, body and footer, but it is not mandatory. However if you use the Thead 
or TBody you must use both together.

 � <Table> Table: Signifies a Table Object
 � <Thead> Table Header: Signifies the Heading section of a table (not always be present)
 � <TBody> Table Body: Signifies the Body section of a table (not always be present)
 � <TFoot> Table Footer: Signifies the Footer section of a table (not always be present)
 � <TR> Table Row: Specifies a table row.
 � <TH> Table Header Cell: Specifies a Heading Cell in a table row or column
 � <TD>Table Data Cell: Specifies a Data Cell in a table row or column
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Label and List Elements
List elements can be ordered or unordered lists. The <L> is the Parent tag 
and all other tags are nested inside it. At minimum the list must contain a 
<L>,<LI> and an <Lbody>.

 � <L> List: List of items. Can be numbered or bulleted.
 � <LI> List Item: Container for the content pair <Lbl><Lbody>
 � <Lbl> Label: Optional item that holds the bullet or number 
 � <Lbody> List Item Body: Mandatory item holding the contents of the item and may 

contain the bullet as well.

Illustration Elements
These tags will always require alternate text 
or actual text properties depending on their 
use. Descriptive text should be limited to a 
couple of sentences that describe the main 
purpose or text within the element. 

 � <Figure> Figure: Anything that is graphical in 
nature. (photo, chart, graph, infographic)
 � <Form> Form: Signifies Form content containing the form - OBJR element
 � <Formula> Formula: Contains a mathematical formula
 � <Caption>Caption: A brief portion of text describing a table or figure.
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Inline-Level Elements 
 � <Link> Link: Hyperlink tag containing the Link - OBJR
 � <Note> Note: Footnote/endnote element. Should be accompanied by <Lbl>
 � <Reference> Reference: Internal reference element. Should be accompanied by <Lbl>
 � <Annot> Annotation: Typically holds comments or other output.
 � <BibEntry> Bib. Entry: Bibliography entry content
 � <Quote> Quote: Inline version of the BlockQuote element.
 � <Span> Span: container for ActualText, white-space characters or other metadata
 � Index <Index> A sequence of entries containing identifying text accompanied by a 

reference element that points out the occurrence of specified text.

*Tag definition source: ISO 32000-1:2008, ISO 14289-1 and Tagged PDF Best Practice Guide.

Tag properties
Each of the tags above can have custom properties applied to them. The 
properties differ based on what the tag controls, but all tags start with the 
basic Properties panel. You access this panel by right clicking on any tag 
and selecting Properties.

 � Title: Used for internal reference only. Not read by assistive technology.
 � ActualText: When you want to completely replace an object or existing text with 

something else. Use with caution. To someone using assistive technology the original 
text or object is completely replaced with the phrase you enter here. They will have no 
indication you have replaced the original content.
 � Alternate Text: This is a description of the existing element. This can be used to 

describe a logo, figure, chart, graph or infographic. While not perfectly semantic it can 
also be used to describe a link destination. However this info really belongs in the 
Content Key. See the Preflight Fix-up section for additional info.
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Content Panel
The Content Panel is separated by page. Each page has a drop-down that 
holds the content elements within that page. This can include Artifacted 
(hidden) elements from the tags tree as well as other interactive elements 
and content.

Items in the Content Panel are arranged bottom to top. Meaning, items 
nearest the Page 1 marker are in the back of the document. Items at the 
bottom of the Page 1 content list are in the front or on top of the other 
elements in the list. This matters when you are adjusting the Read Order 
and something goes “missing.” Typically this happens because the missing 
element was re-ordered behind the other elements. Just drag the missing/
hidden element to the bottom of the list to make it reappear.

What you find in the Content Panel
1. Annotations: These are the list of Link-OBJRs on that page.
2. Containers: Each element is listed with its Parent container
3. Artifacts: Decorative elements to be hidden from the screen reader.
4. Form XObjects: Repeating elements typically created on Master pages. These objects 

only get stored once in a PDF but referenced multiple times. Consider Form XObjects 
as mini-PDF files embedded inside the main PDF document

5. Untagged Content: Content that is not in the Tags Tree nor has not been tagged as 
an Artifact will appear without the word Container before it.

2

1

4

5

3
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Order Panel
The Order Panel is similar to the Content Panel. It displays the 
Construction Order of the document. This can be different than the 
Tag Order. Numbers are displayed on each element that indicates the 
Construction Order. This is not to be confused with the order in which 
assistive technology will read the document. Conforming assistive 
technology is required to use the Tag Order to voice the content. However, 
there are older assistive technology that still read the Order Panel (like 
Adobe’s Read Aloud) that are not actually considered conforming assistive 
technology. They are designated as “Text to Speech” Tools and still rely on 
the outdated use of the Order Panel to voice the flow of the text.

Tag Order or Read Order? What does all this mean?
If you want your document to be as bullet-proof conforming as possible 
for new and old assistive technology, you should set the Construction 
Order as well as the Tag Order. This is in keeping with WCAG 2.1 Guideline 
4.1 Compatible: “Maximize compatibility with current and future user 
agents, including assistive technologies.” It is also supported by Success 
Criterion 1.3.2: Meaningful Sequence: “a correct reading sequence can be 
programmatically determined.”

Accessibility Warning: It is recommended that you use the Content Panel 
to arrange the Order, not the Order Panel. If you have modified your 
Tags Panel to be 100% correct and clean before setting the Order Panel, 
the current version of Adobe Acrobat can and will rearrange your Tags by 
combining tags and containers. So either start with the Order Panel and 
then fix your Tags or use the Content Panel to adjust your Order. 

https://www.w3.org/WAI/WCAG22/Understanding/compatible
https://www.w3.org/WAI/WCAG22/Understanding/compatible
https://www.w3.org/WAI/WCAG21/Understanding/meaningful-sequence
https://www.w3.org/WAI/WCAG21/Understanding/meaningful-sequence


Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro  |  Adobe MAX 2021 

19

Accessibility Tool Panel 
(Brief Overview)

Autotag Document 
While there are some cases where Autotag is viable, 
you should never autotag a document that already 
contains accessibility tags. Autotag can work well 
for simple documents that do not contain scanned 
content, tables or other complex elements. If you 
receive a document that contains no tags, you can 
try the autotag feature and make the judgment to 
keep it or manually tag it based on the accuracy of 
the results. 

AutoTag Form Fields
This feature is supposed to add the correct tags from your previously 
created form elements. It is suggested that you use Prepare Form instead. 
However, this method will simply create the Form Objects but you will 
still need to allow the Tags Tree to detect each Form OBJR and add it to 
the Tags Tree. You can access the Find tool by right clicking on any tag and 
from the context menu choosing Find > Unmarked Annotations. Once 
the Form OBJRs have been detected they will need to be moved into the 
correct reading order as well. It is an arduous process for sure.

Forms Note: It is always best to create your forms in Adobe InDesign where 
you can export them with tags and in the correct reading order. Neither the 
Autotag nor the Prepare Form > auto detect form fields provide a single-
click solution. 
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Reading Options
When using assistive technology you can set two options for how many 
pages to pre-load into the screen reader. When a document is more than 
50 pages Acrobat will sometimes set this to Read Currently Visible Page 
Only to prevent overloading the readers computer. You will know when this 
happens because the document will seem to only identify the headings or 
other elements on the current page. The shortcut to access this menu item 
is Ctrl/Cmd + Shift + 5.

Reading Note: You should not change the Reading Order drop-down. 
Tagged Reading Order is always the best choice for a tagged document.
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Accessibility Checker

What are we checking for?
The Accessibility Checker criteria are divided into four main categories. In 
each one of these categories you can see the elements it is checking for. It is 
recommended that you keep these settings as is. If your local laws exclude 
some of these criteria you can choose to uncheck any element to skip them. 
The only element unchecked by default is Table Summaries. While these 
can be useful, they are not required by the Web Content Accessibility 
Guidelines .

 � Document
 � Page Content
 � Forms, Tables and Lists
 � Alternate Text and Headings

Compliance Warning: It is worth noting that the Acrobat Checker (or 
any automated checker for that matter) is only a first step in verifying a 
document conforms to accessibility standards. It is only through a series of 
manual and automated checks can a document be properly evaluated for 
accessibility.
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Running the checker
By default the accessibility report is saved to your local computer and can 
be attached to the current PDF document by checking the Attach Report to 
Document checkbox .

Once you have selected the options you wish (typically you should leave 
everything in their default settings) you can click Start Checking . The 
Checker will review your document and the report will appear on the left in 
the Tools Pane. You will see a red X for the items that failed and a link to the 
elements that require attention. 

Fixing the Errors
For many errors you can right click on the element and choose Fix (1)to 
bring up additional options for fixing the error. You can also choose Explain 
(2) to load a brief explanation of why the element has failed. Once you have 
cleared the error you can return to the report and right click on the error 
and choose Check Again (3). 

2
1

3
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Clearing the 5 most Common Errors
1 . Missing Title
Often Acrobat will not recognize when a title already exists and it will report 
it as a failure. Simply right click on the Title error and choose Fix. Acrobat 
will automatically recognize the title does exist and clear the error. 

If the Title does not exist a Properties Panel will open up to allow you 
to add the Title quickly. Alternatively you can go to File > Properties and 
enter it there as well as the other meta data for the document.

2 . Missing Language
Go to File > Properties > Advanced and select the appropriate base 
language for the document from the Language drop-down. If the base 
language does not exist in the drop-down you can look up the two letter 
code from the ISO  639-1 Language Code List.

Language Note: Remember that the end user must have the proper 
language pack installed on their machine in order for the screen reader to 
voice it correctly.

https://www.loc.gov/standards/iso639-2/php/code_list.php
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3 . Missing Alt-text
All figures must have a text description that provides context to the reader 
and describes the meaningful information intended for the reader. This 
description should be no more than 250 characters on average. It should 
be concise and contain only the information needed to describe the image, 
figure, chart or graph. Before adding Alt-text ask yourself if the image is 
decorative or meaningful. If it is purely decorative or abstract in nature then 
you should mark the image as an Artifact (hidden).

This error can be fixed in two methods.

Method 1 

1. Right click on the first Figure Error in 
the report and select Fix. 

2. Acrobat will automatically navigate 
to the appropriate page and allow you 
to enter a description or mark it as a 
Decorative Figure. 

3. Once you have entered a description click the Right Arrow at the top of 
the dialog box to cycle through to the next image. 

4. When finished click the Save & Close button.

Method 2

1. Right click on the Figure 1 and select 
Show in Tags Panel. This will navigate you 
to the appropriate <Figure> tag. 

2. Right click on the tag and choose 
Properties. Then enter the Alternate Text 
in the correct box. 

3. Click Close when finished. 

4. Now go back to the Figure error in the 
report and click Check Again.

Accessibility Note:  Remember that Alt-Text cannot be paused. So keep 
your descriptions meaningful but brief.
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4 . Heading Structure
This error is due to skipping numbers in your Headings. Heading levels must 
be logical and cannot skip over numbers. For example, you cannot go from 
Heading Level 1 to Heading Level 3. To fix this error:

1. Right click on the Element 1 and 
select Show in Tags Panel.

2.  Look for the previous Heading 
Level to identify the next logical 
number. 

3. Right click on the offending 
Heading Level and choose 
Properties. 

4. In the Type drop-down you can 
start typing or scroll until you find 
the appropriate heading level. 

5. Choose it and click Close. 

6. Now go back to the Figure error in the report and click Check Again.



Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro  |  Adobe MAX 2021 

26

5 . Table Irregularity
Most of the table irregularity issues are due to merged cells not having the 
appropriate Column Span or Row Span properties set. The main goal is 
to make sure your table is a perfect rectangle with the same number of 
columns and rows.

Visual Representation

North
12 10 6
14 15 12

South
16 9 8
13 14 10

Tagged Representation

In the example you can clearly see the missing cell. This is because the Row 
Span property for the Heading Cell for North is incorrect and should be a 
value of 2 not 1.
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Other Accessibility Tools

Auto-Identify Form Fields
Auto-Identify Form Fields works just like the tool in Prepare Forms. It 
simply creates the form fields (1) and the annotations (2) but does not 
add them to the Tags Tree. This must be done manually by using Find > 
Unmarked Annotation (3). Once added to the Tags Tree (4) , they must 
each be repositioned to reflect the proper reading order (5).

Forms Note: It is always best to create your forms in Adobe InDesign where 
you can export them with tags and in the correct reading order. Neither the 
Autotag nor the Prepare Form > auto detect form fields provide a single-
click solution. 

3

12

4

5
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Set Alternate Text
Set Alternate-Text is very similar to the Fix command from the 
Accessibility Report. The only difference is that this tool cycles through all 
the images in your document to allow you to verify they do or do not have 
alt-text applied. This is a convenient way to double-check your work without 
having to hunt down <Figure> tags in the Tags Tree.

1. Select Set Alternate-Text. 

2. Acrobat will automatically cycle through each image and display any 
existing alt-text or display a blank field to allow you to enter a description or 
mark it as a Decorative Figure. 

3. Once you have entered a description click the Right Arrow at the top of 
the dialog box to cycle through to the next image. 

4. When finished click the Save & Close button.



Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro  |  Adobe MAX 2021 

29

Accessibility Setup Assistant
This is one of those boxes that 
you really should just leave as 
default. If you are using a screen 
reader or screen magnifier yourself 
you can adjust properties within 
these menu items. However for 
90% of the cases, you will want to 
leave this as Use Recommended 
Settings and Skip Setup.

Reading Order Panel

Which Assistive Technology uses this panel?
Before Tags were implemented the Order Panel was how assistive 
technology read the content in the document. This practice has since been 
phased out but there are still technologies like TextHelp Read & Write and 
several other programs that still rely on this panel.

Why it may be important to set this?
If you are trying to meet the highest level of compatibility with all assistive 
technology, you will want to ensure the Reading Order is set to match the 
Tags Tree. However, as previously explained, if you start rearranging these 
elements in the Order Panel, your tags will very likely move, combine or 
otherwise change. So if you have already edited your tags tree it is highly 
recommended that you use the Content Panel rather than the Order Panel 
to restructure the Reading Order.
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Reading Order Panel Explained
1. Tagging Tools: Draw a box around any element on the page and then 
Click the appropriate button to tag that element. Your tag will appear in the 
next logical order below your currently selected element in the Tags Tree, 
Order Panel or Content Panel.

2. Table Editor Tool: Allows you to edit table properties for header and data 
cells. When you click on the table the Reading Order Panel will disappear. 
You can select it from the Tools Panel to reactivate it.

3. Table Summaries: These can only be edited by selecting your table, right 
clicking and choosing Edit Table Summary.  

4. Visual Options: These options allow you to group and ungroup similar 
items in the Reading Order view as well as show or hide tables, table cells 
and figures.

3 1

2
4
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Preflight Panel

Basic fixes you should know

You can access the Preflight Panel from the Print Production Tool. 
The Preflight Panel is a hidden gem of accessibility quick fixes for your 
documents. These are just my top 5 (plus one extra) but all of them are 
valuable and can save tons of time as you learn to remediate documents. 
They are divided into 6 categories. Take the time to see what they do.

1. Add Note IDs: This fix adds a unique identifier for each Note in a 
document. This is a requirement that all notes are individually identified.

2. Embed Fonts: Does exactly what you expect. Ensures the fonts 
associated with the document are properly embedded for accurate display 
on any computer.

3. Artifact all non-structural elements: PDF/UA says that all elements 
must have a tag or be marked as Artifacted. No elements can just exist in 
the Content Panel without designation. This fix sets things like table borders, 
underlines and other decorative elements as Artifacts.

3
1

2
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4
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4. Setting Standard Bullet voicing: Many people are unaware that not 
all bullets are voiced the same. Some are not even recognized by screen 
readers. This fix ensures that all bullet icons regardless of type are voiced as 
“Bullet” to ensure a consistent user experience.

5. Create Content Entry for Link Annotations: The Web Content 
Accessibility Guidelines Success Criteria 2.4.4 Link Purpose state that “the 
purpose of each link can be determined from the link text alone or from 
the link text together with its programmatically determined link context.” In 
other words, links need descriptions. Most people do not know how to set 
the value in the Content Key, so they simply add alt-text. This fix up sets the 
value of the link in the Content Key per PDF/UA-1 guidelines.

6. Set the PDF/UA Identifier: Adds a marker to the document signifying 
that the document is attempting to meet PDF/UA standards. 

What is PDF/UA?
ISO Standard 14289: PDF for Universal Access - (PDF/UA) while WCAG 
provides basic principles to follow without addressing the technical aspect 
of the tags tree or the underlying document structure, PDF/UA advocates 
for the standardization of the content structure within the PDF files and 
the technology capabilities available to the end user (including assistive 
technologies).

Benefits of PDF/UA
Clear technical requirements 
Clearly defined and well-
documented requirements that 
serve as orientation for developers, 
implementers, service providers and 
procurers.

Guaranteed compatibility 
Relevant software, hardware and 
digital documents can work together 
as effectively as possible – provided 
they comply with the standard.

https://www.w3.org/TR/UNDERSTANDING-WCAG20/navigation-mechanisms-refs.html
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Basis for defined machine 
checks
108 machine verified success criteria 
defined in the so-called Matterhorn 
Protocol are a good basis for 
reliable validation of accessible PDF 
documents.

Best possible user experience
PDF/UA compliant documents 
deliver the best possible user 
experience of PDFs for people with 
disabilities and users of mobile 
devices.

Complementary to WCAG
Missing link between PDF 
specification and the global 
requirements for accessible digital 
content as described in WCAG (Web 
Content Accessibility Guidelines) of 
W3C.

Fully addresses the PDF 
format
Bringing the principles of WCAG into 
the world of PDF and setting PDF-
specific rules.

Content prepared for mobile 
view and re-use
Future-proof presentation of 
content with rich semantics and 
machine-readability and advanced 
adaptability options, such as mobile 
view.

Product and company 
independent
As a global and independent product 
standard, PDF/UA guarantees 
comparable checking results and 
reliable requirements on which end-
users should focus when choosing 
software.

Globally accepted and 
implemented
Initially published in 2012, PDF/UA 
is now an accepted and widely used 
part of the digital accessibility and 
PDF ecosystem and referenced in 
legislation.

Focus on technical 
accessibility
WCAG already covers all content 
and layout-related aspects of digital 
accessibility. PDF/UA, therefore, 
focuses on the technical aspects.

Equal access to content for 
everyone
Every document is usable, readable 
and accessible for all users - no 
matter what disability they may 
have.

Source:  
PDF UA Foundation Website

https://pdfua.foundation/en/why-pdf-ua
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Useful WCAG/A Links
Current Version of WCAG 2.1
https://www.w3.org/TR/WCAG21

How to Meet WCAG (Quick Reference)
https://www.w3.org/WAI/WCAG21/quickref

PDF Techniques for WCAG 2.1
https://www.w3.org/WAI/WCAG21/Techniques

Web Accessibility Laws & Policies
https://www.w3.org/WAI/policies

How People with Disabilities Use the Web
https://www.w3.org/WAI/people-use-web

International Association of Accessibility Professionals
https://www.accessibilityassociation.org/

PDF/UA Standards & Manuals
PDF 1.7 (ISO 32000-1)
https://www.iso.org/standard/51502.html

PDF/UA-1 (ISO 14289-1)
https://www.iso.org/standard/64599.html

Matterhorn Protocol 1.1 PDF/UA Conformance Testing
https://www.pdfa.org/resource/the-matterhorn-protocol

Useful Accessibility Tools
Color Contrast Analyzer
https://www.tpgi.com/color-contrast-checker

Contrast Grid
https://contrast-grid.eightshapes.com/

PAC 2021 Accessibility Checker
https://pdfua.foundation/en/pdf-accessibility-checker-pac

Colorblind Simulation (Windows)
https://www.microsoft.com/en-us/p/coloursimulations/9nblggh4385h

Daltonizer (MAC)
https://apps.apple.com/us/app/sim-daltonism/id693112260

Callus PDF Go (Structure Checker)
https://www.callassoftware.com/en/products/pdfgohtml

InDesign Accessibility Scripts:  Alt-text, Color Contrast and Tables
Accessibilityscripts.com

Made to Tag InDesign Script for Accessible Tables
https://www.axaio.com/doku.php/en:products:madetotag

Axes PDF Quickfix
https://www.axes4.com/en/products-services/axespdf

https://www.w3.org/TR/WCAG21 
https://www.w3.org/WAI/WCAG21/quickref 
https://www.w3.org/WAI/WCAG21/Techniques 
https://www.w3.org/WAI/policies 
https://www.w3.org/WAI/people-use-web 
https://www.accessibilityassociation.org/ 
https://www.iso.org/standard/51502.html 
https://www.iso.org/standard/64599.html 
https://www.pdfa.org/resource/the-matterhorn-protocol 
mailto:https://www.tpgi.com/color-contrast-checker?subject=
https://contrast-grid.eightshapes.com/ 
mailto:https://pdfua.foundation/en/pdf-accessibility-checker-pac?subject=
https://www.microsoft.com/en-us/p/coloursimulations/9nblggh4385h 
https://apps.apple.com/us/app/sim-daltonism/id693112260 
https://www.callassoftware.com/en/products/pdfgohtml 
https://www.Accessibilityscripts.com 
https://www.axaio.com/doku.php/en:products:madetotag 
https://www.axes4.com/en/products-services/axespdf 
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Summary

Start with the basics
Accessibility takes time to wrap your head around. 
There are so many facets to understand. Realize that 
some accessibility now is better than none. Your 
skills will grow and the accessibility and usability 
of the documents you create will improve. Like I 
always say, it is about Awareness, Knowledge and 
Implementation. 

Get familiar with the tools
Take the time to learn new things from videos, 
conferences, labs and peers. There is a lot of 
information out there and there are a lot of tools 
within Adobe Acrobat and via plugins and 3rd-party 
tools as well. But, if you do not understand the basics 
of accessibility, all the tools in the world will not 
produce an accessible document. Accessibility will 
always rely on automated and manual checks that 
require human evaluation.

Get involved in the A11y Community
1. Join the PDF Accessibility Facebook group

2. Get certified as an Accessible Document Specialist

3. Join a local accessibility Meetup in your area

4. Look for others on social media following #a11y

5. Reach out to your local Society for the Blind

Still have questions?
Reach out to me and I will be happy to answer them:

dcastro@abledocs.com

mailto:dcastro%40abledocs.com?subject=AdobeMAX

	About this document
	Instructor
	Introduction
	What Is Digital Accessibility?
	Accessibility Barriers
	International (WCAG-based) Accessibility Standards 

	The Acrobat Workspace
	The Four Interface Areas
	The Three Acrobat Views

	File Properties Basics
	Title
	Language

	Bookmarks
	Auto-generate via Headings
	Manually create

	Tool Panels you need to know
	Tags Panel
	Tags you need to know
	Content Panel
	Order Panel

	Accessibility Tool Panel
(Brief Overview)
	Autotag Document 
	AutoTag Form Fields
	Reading Options

	Accessibility Checker
	What are we checking for?
	Running the checker
	Clearing the 5 most Common Errors

	Other Accessibility Tools
	Auto-Identify Form Fields
	Set Alternate Text

	Accessibility Setup Assistant
	Reading Order Panel
	Which Assistive Technology uses this panel?
	Why it may be important to set this?
	Reading Order Panel Explained

	Preflight Panel
	Basic fixes you should know

	What is PDF/UA?
	Benefits of PDF/UA
	Useful WCAG/A Links
	PDF/UA Standards & Manuals
	Useful Accessibility Tools

	Summary
	Start with the basics
	Get familiar with the tools
	Get involved in the A11y Community
	Still have questions?




Accessibility Report


		Filename: 

		L200-Workbook-Final.pdf




		Report created by: 

		Dax Castro, Accessible Document Specialist, dax@daxcastro.com

		Organization: 

		International Association of Accessibility Professionals




 [Personal and organization information from the Preferences > Identity dialog.]


Summary


The checker found no problems in this document.


		Needs manual check: 2

		Passed manually: 0

		Failed manually: 0

		Skipped: 1

		Passed: 29

		Failed: 0




Detailed Report


		Document



		Rule Name		Status		Description

		Accessibility permission flag		Passed		Accessibility permission flag must be set

		Image-only PDF		Passed		Document is not image-only PDF

		Tagged PDF		Passed		Document is tagged PDF

		Logical Reading Order		Needs manual check		Document structure provides a logical reading order

		Primary language		Passed		Text language is specified

		Title		Passed		Document title is showing in title bar

		Bookmarks		Passed		Bookmarks are present in large documents

		Color contrast		Needs manual check		Document has appropriate color contrast

		Page Content



		Rule Name		Status		Description

		Tagged content		Passed		All page content is tagged

		Tagged annotations		Passed		All annotations are tagged

		Tab order		Passed		Tab order is consistent with structure order

		Character encoding		Passed		Reliable character encoding is provided

		Tagged multimedia		Passed		All multimedia objects are tagged

		Screen flicker		Passed		Page will not cause screen flicker

		Scripts		Passed		No inaccessible scripts

		Timed responses		Passed		Page does not require timed responses

		Navigation links		Passed		Navigation links are not repetitive

		Forms



		Rule Name		Status		Description

		Tagged form fields		Passed		All form fields are tagged

		Field descriptions		Passed		All form fields have description

		Alternate Text



		Rule Name		Status		Description

		Figures alternate text		Passed		Figures require alternate text

		Nested alternate text		Passed		Alternate text that will never be read

		Associated with content		Passed		Alternate text must be associated with some content

		Hides annotation		Passed		Alternate text should not hide annotation

		Other elements alternate text		Passed		Other elements that require alternate text

		Tables



		Rule Name		Status		Description

		Rows		Passed		TR must be a child of Table, THead, TBody, or TFoot

		TH and TD		Passed		TH and TD must be children of TR

		Headers		Passed		Tables should have headers

		Regularity		Passed		Tables must contain the same number of columns in each row and rows in each column

		Summary		Skipped		Tables must have a summary

		Lists



		Rule Name		Status		Description

		List items		Passed		LI must be a child of L

		Lbl and LBody		Passed		Lbl and LBody must be children of LI

		Headings



		Rule Name		Status		Description

		Appropriate nesting		Passed		Appropriate nesting






Back to Top
